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Chapter 1. Introduction 

This quick start is addressed to users of the NVIDIA® Control Panel software. This guide 
focuses on getting you up and running with your NVIDIA software. 

For technical details on the features and benefits of the NVIDIA Control Panel software 
and details about supported products, drivers, and other software, refer to the NVIDIA web 
page — www.nvidia.com. 

This chapter discusses the following major topics:  

 About the NVIDIA Control Panel  

 Getting Support and Information  

1.1 About the NVIDIA Control Panel 
Welcome to the NVIDIA Control Panel, designed for Microsoft® Windows®. You can use 
NVIDIA Control Panel to control your NVIDIA hardware and access other NVIDIA software 
installed on your system. 

1.1.1 Overview 
In addition to setting up basic display configurations such as display resolution, refresh 
rate, and multiple display use, you can: 

1. Tune your 3D settings with real-time preview to maximize performance or image 
quality. 

2. Customize how 3D applications work in your system. 

3. Adjust your screen colors and contrast. 

4. Set custom timings. 

5. Control video image settings. 

6. Change your HDTV format. 

7. Control special workstation features such as Frame Synchronization.  
 

 
Caution: The NVIDIA Control Panel can be viewed with a desktop DPI scaling set to a 
maximum of 250%. Setting the DPI higher than 250% may result in some content getting 
cut off from view. 

 

http://www.nvidia.com/
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1.1.2 Supported Operating Systems 
NVIDIA Release 535 RTX professional drivers are available for the following Microsoft® 

Windows® operating systems: 

1. Windows 10 64-bit 

2. Windows 11 

3. Windows Server 2019 (64-bit) 

4. Windows Server 2022 (64-bit) 

Refer to the release notes for specific operating system support for individual driver 
versions. 

1.1.3 Supported NVIDIA Products 
Refer to the release notes and NVIDIA driver download site for the list of products 
supported by the driver version that you have installed on your computer. 

1.1.4 Supported Languages 
The NVIDIA Graphics Driver supports the following languages in the NVIDIA Control Panel: 

 

English (USA) German Portuguese (Euro/Iberian) 

English (UK) Greek Russian 

Arabic Hebrew Slovak 

Chinese (Simplified) Hungarian Slovenian 

Chinese (Traditional) Italian Spanish 

Czech Japanese Spanish (Latin America) 

Danish Korean Swedish 

Dutch Norwegian Thai 

Finnish Polish Turkish 

French Portuguese (Brazil)  
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1.2 Getting Support and Information 

1.2.1 Online Help 
1. To open the online help, either: 

a. Press F1 on your keyboard, or 

b. Select Help from the NVIDIA Control Panel menu bar and then select NVIDIA 
Control Panel Help. 

2. Help on various topics can be viewed using the Contents, Index, or Search tabs. 

1.2.2 Technical Support 
To access the NVIDIA Technical Support webpage go the following:  

http://www.nvidia.com/page/support.html 

1.2.3 System Information 
You can get detailed information about your system and the NVIDIA Control Panel 
configuration as well as version and copyright information. 

1. To view copyright and version information about the NVIDIA Control Panel:  

From the Help menu, select About NVIDIA Control Panel. 

2. To view detailed system information: 

Open the System Information dialog box by either selecting System Information 
from the Help menu, or by clicking the System Information link at the lower left 
corner of the NVIDIA Control Panel. 

Click any of the tabs in the System Information dialog box. 

http://www.nvidia.com/page/support.html
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Chapter 2. Understanding the NVIDIA 
Control Panel 

This chapter describes the NVIDIA Control Panel in the following sections:  

 Opening and Closing the NVIDIA Control Panel  

 About the NVIDIA Control Panel Interface  

2.1 Opening and Closing the NVIDIA 
Control Panel 

2.1.1 Opening the NVIDIA Control Panel  
 

 
Caution: The NVIDIA Control Panel can be viewed with a desktop DPI scaling set to a 
maximum of 250%. Setting the DPI higher than 250% may result in some content getting 
cut off from view. 

 

To open the NVIDIA Control Panel, right-click the desktop and then select NVIDIA Control 
Panel. 

2.1.2 Closing the NVIDIA Control Panel 
To close the NVIDIA Control Panel: 

 From the File menu, select Exit, or 

 Click the Close box in the upper right corner of the program window. 

2.2 About the NVIDIA Control Panel 
Interface 

The NVIDIA Control Panel provides an easy-to-use interface for managing your system. 

When you start the program for the first time, the NVIDIA Control Panel opens to the first 
page listed in the navigation tree. On subsequent visits, the control panel reopens to the 
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last page visited. The NVIDIA Control Panel user interface consists of these main areas, as 
shown in Figure 1: 

 Main Task Area 

 Select a Task (Navigation tree)  

 Menu bar  

 Toolbar 

Figure 1. NVIDIA Control Panel 

Toolbar Menu Bar  

Select a Task Pane Control Panel Main Task Area 

2.2.1 Using the Main Task Area 
The main task area, in the right pane, displays the application task pages. This area of the 
screen is where you will focus most of your attention as you use the NVIDIA Control Panel 
to accomplish your goals. You can access specific pages using the navigation tree in the 
Select a Task pane. 

Depending on your PC manufacturer, there is a Welcome page that appears the first time 
you open the NVIDIA Control Panel after installing the driver. On subsequent visits, the 
control panel reopens to the last page visited. 
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2.2.2 Using the Select a Task Pane 
The navigation tree in the Select a Task pane shows all the primary NVIDIA Control pages 
that are installed on your system. 

The pages are grouped according to the same categories that existed in the previous 
version of the NVIDIA Control Panel. 

Figure 2. NVIDIA Control Panel Select a Task pane 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 
 
 

2.2.3 Using the Toolbar 
The Toolbar provides quick back and forth navigation between pages. The back and forward 
buttons let you navigate sequentially among pages that you have visited. 

You can also navigate directly to a previously visited page by clicking the list arrow next to 
the back button. The drop-down menu lists all the previously visited pages in the queue. 
Click the page that you want to open. 

Click to open the corresponding page in 
the main task area.  

Click to expand or 
collapse the group list.  
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Figure 3. Navigation History Menu 

2.2.4 Using the Menu Bar 
The Menu Bar contains standard Windows menus and menus specific to the NVIDIA 
Control Panel, such as the View and Profiles menus. 

Menus that are available on the menu bar may vary, depending on the NVIDIA Control Panel 
group (such as, Display, Mobile, 3D Settings, or other group) you are using. 

2.2.4.1 File Menu 
Commands related to printing, applying changes, and exiting the program are available on 
the File menu.  

Table 1. File Menu Commands 

File Menu 
Command 

Description 

Page Setup ... Set up the current task page for printing. This control may not be available. 

Print... Print the current task page. This control may not be available. 

Print Preview.... Preview the page before sending it to the printer. This control may not be available. 

Exit Close the NVIDIA Control Panel program. 

 

2.2.4.2 Edit Menu 
Commands related to cutting, copying, pasting, and selecting items are available on the 
Edit menu.  

Table 2. Edit Menu Commands 

Edit Menu 
Command 

Description 

Cut Cut the selected text and place in the clipboard. This control may not be available. 

Copy Copy the selected text and place in the clipboard. This control may not be available. 
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Edit Menu 
Command 

Description 

Paste Paste the text currently in the clipboard to the location of the Windows cursor. This 
control may not be available. 

Select All Select all items on the current page. This control may not be available. 

2.2.4.3 Desktop Menu 
Commands related to viewing the various pages in the NVIDIA Control Panel application 
modules are available on the Desktop menu.  

Table 3. Desktop Menu Commands 

View Menu 
Command 

Description 

Add Desktop 
Context Menu 

This is selected by default and adds the NVIDIA Control Panel menu item to the Desktop 
Context menu. 

Enable Video 
Editing Mode 

Select this option to improve the video playback experience for some video editing 
applications. 

Add the Run with 
graphics 
processor Option 

Select this option to add Run with graphics processor to the program context menu. 

When this option is selected, you can choose which graphics processor to use when 
starting a program as follows: 

1. Right-click the program icon. 

2. Click Run with graphics processor and then click the graphics processor to use.  

The selection applies only at the time the program is launched.    
 

 
Note: This menu option appears only with systems using NVIDIA© 
Optimus™ technology. 

 

 
Note: This menu option will not appear with Windows 10 May 2020 
Update and later. 

 

 
Note: Some programs require elevated user privileges to use the 
Run on graphics processor option from the program's right-click 
menu. A pop-up dialog will let you know if that is the case. In this 
case, use the controls in the NVIDIA Control Panel -> Manage 3D 
Settings page to select the graphics processor. 

  

Display GPU 
Activity Icon in 
Notification Area 

Select this option so that the GPU Activity icon appears in the Windows notification area 
of the taskbar. You can then click the icon to see which programs and displays are using 
the NVIDIA GPU.  

 

 
Note: This menu option appears only with systems using 
NVIDIA© Optimus™ technology. 
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2.2.4.4 Help Menu 
Commands related to accessing help, system information, and copyright and version 
information are available on the Help menu.  

Table 4. Help Menu Commands 

Help Menu Command Description 

NVIDIA Control Panel Help Access the NVIDIA Control Panel online help. 

System Information View detailed information about your system and the NVIDIA Control Panel 
configuration. 

Debug Mode Removes all overclocking performance and power settings. 

About NVIDIA Control Panel View NVIDIA Control Panel version and copyright information. 

 

2.2.4.5 Group-Specific Menus 
These menus appear only when pages from a specific group are open. 

2.2.4.5.1 Display Menu 

This menu item appears only when a Display group page is open.  

Table 5. Display Menu Commands 

Display Menu Command Description 

Identify Displays Select to identify the displays configured with your system. 

Show G-SYNC Visual 
Indicator 

Select to verify that NVIDIA G-SYNC is being used. Depending on the type of 
monitor connected, the menu item could state: 

• Show indicator for G-SYNC, 

• Show indicator for G-SYNC Compatible, or 

• Show indicator for G-SYNC/G-SYNC Compatible 

2.2.4.5.2 3D Settings Menu 

This menu item appears only when a 3D Settings group page is open on an SLI system. 

Table 6. 3D Settings Menu Commands 

3D Settings Menu 
Command 

Description 

Show SLI Visual Indicators Select to verify that SLI rendering or SLI antialiasing is enabled and working. 

Show Multi-GPU Visual 
Indicator 

Select to verify that multi-GPU rendering or multi- GPU antialiasing is enabled 
and working. 

Show PhysX Visual Indicator Select to verify the type of PhysX acceleration the game is using - CPU or GPU 
- or if PhysX acceleration is being used at all. 
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2.2.4.5.3 Workstation Menu 

This menu item appears only when a Workstation group page is open.  

Table 7. Workstation Menu Commands 

Workstation Menu 
Command 

Description 

Refresh View Select to refresh the graphical representation of the displays and graphics 
cards installed on your system. 
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Chapter 3. Accomplishing NVIDIA 
Control Panel Tasks 

The NVIDIA Control Panel provides an intuitive layout for locating graphics driver controls, 
including most of the controls that were available with the Classic NVIDIA Control Panel. 

 NVIDIA Control Panel Feature List details the current features available in the 
NVIDIA Control Panel. 

 NVIDIA Control Panel Groups provides an overview of the NVIDIA Control Panel 
pages by group.  

3.1 NVIDIA Control Panel Feature List  
 

 
Caution: With Optimus systems under Windows 10, the Display controls are not available if 
no display is connected to the NVIDIA GPU. This is because clone mode across display 
adapters is handled by the Windows OS and not by the NVIDIA driver.  

 

Table 8. NVIDIA Control Panel Features  

Feature Values (Default in bold)a Notes 

Display/TV Controls 

Mode control 

Resolution 
• Non-HD display - the native 

resolution or the highest safe 
resolution from the monitor EDID 
is the default. 

 

 • HD display - the highest 
progressive resolution is the 
default. 

Refresh rate   

Custom timings/resolutions   

TV Signal Format Selection M/NTSC, PAL, M/PAL, N/PAL, 

Select by country 
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Feature Values (Default in bold)a Notes 

Connector Selection Auto-select, DVI 

VGA 

S-Video - SDTV, Component 
Composite - SDTV, 

HDMI - HDTV (Vista and later), 

DisplayPort - HDTV (Vista and later), 

LVDS - laptop display 

Available values depend on the 
actual connection. 

Desktop Color depth Highest (32-bit) Medium (16-bit) HDR 
(64-bit) WCG (64-bit) 

SDR (30-bit color) 

SDR (24-bit color) 

 

Output Color Depth 8 bpc 

12 bpc 

Display dependent 

Output Dynamic Range Full (0—255) 

Limited (16—235) 

 

Output Color Format RGB, YCbCr422 For HDMI and DisplayPort 
connections 

Color Control 

Color Accuracy Mode (read only) Reference (can be forced via check 
box) 

Accurate Enhanced 

 

Brightness 0 - 100%, (50%)  

Contrast 0 - 100%, (50%)  

Gamma 0.50 - 1.50, (1.00)  

Digital Vibrance 0 - 100%, (0%)  

Hue 0 - 359 degrees (30) For GeForce 8 series and later 
GPUs 

Flicker Filter 0 - 100%, (50%) For analog TVs 

Gray border option Disabled For analog TVs; presents unused 
black TV borders as gray 

Content type (ITC) reported to the 
display 

Auto select, Desktop programs, Full-
screen videos, Photos, Movie, Games 

Some HDMI displays only - 
available values dependent on 
display support 

NVIDIA G-SYNC Enable G-SYNC/G-SYNC Compatible Windows 10 and Pascal or later 
GPUs required for G-SYNC 
Compatible displays. 

Rotation 0, 90, 180, 270 degrees  

Desktop Size and Position 

Move CRT screen position  For VGA displays 

Scaling mode Aspect ratio  
Full-screen  
No scaling 
Integer scaling 

TV, VGA (with EDID), 

Digital displays, LVDS 
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Feature Values (Default in bold)a Notes 

Scaling performed on GPU 

Auto (Display/GPU combination) 

Application Scaling override Off, On 

Resize  TV, Digital displays 

Position  TV, VGA 

Multi-display Options 

Single-display mode   

Dualview (extended mode)   

nView Clone Mode   

Smart Clone   

Set Up Merge Displays  Windows 10 and later 

Video Controls Use video player settings is the default. If Use NVIDIA settings is selected, the following 
values apply. 

Color Settings 

Brightness 0 - 100%, (50%)  

Contrast 0 - 100%, (50%)  

Hue 0 - 100%, (0%)  

Saturation 0 - 100%, (50%)  

Gamma (including separate RGB) 0.3 - 3.00, (1.00)  

Advanced Color Settings 

Dynamic Range Full (0—255) 

Limited (16—235) 

 

Dynamic Contrast Enhancement Disabled  

Color Enhancement Disabled  

Image Settings 

Edge Enhancement 0 - 100%, (0%)  

Noise Reduction 0 - 100%, (0%)  

Inverse Telecine option Disabled  

Internet Video Enhancement option Disabled  

Digital Audio 

Verify displays that will appear as 
audio devices in the Windows 
Sound Settings. 

For each audio-capable display, select 
the display or select Turn off audio. 

For GPUs that support digital 
audio when an HDMI or 
DisplayPort connection is made. 

Portal to the Windows Sound 
Settings panel. 

  

HDCP 

View HDCP Status (Capability 
verification page) 

 For GPUs that support HDCP. 

3D Application Controls - Manage 3D Settings 

Preferred graphics processor High-performance NVIDIA processor, Optimus systems. 
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Feature Values (Default in bold)a Notes 

Integrated graphics, 

Force high-performance NVIDIA 
processor use, 

Force integrated graphics use, Auto-
select 

Not available as of Windows 10 
May 2020 Update. 

Ambient Occlusion Off, Performance, Quality  

Anisotropic filtering Application-controlled, Off, card-
specific settings 

 

3D Application Controls - Manage 3D Settings 

Antialiasing - Mode Application-controlled, Off, Enhance 
the application setting, Override any 
application setting 

 

Antialiasing - Setting Application-controlled, card- specific 
settings 

 

Antialiasing - FXAA Off, On  

Antialiasing line gamma Off, On  

Antialiasing - gamma correction Off, On  

Antialiasing - transparency Off, Multisampling, supersampling  

Background Application Max Frame 
Rate 

Range: 20-200  

Buffer-flipping mode Auto-select, Block transfer  

CUDA - GPUs [All CUDA-capable GPUs]  

Deep color for 3D applications Allow, disable  

DSR Factors OFF 

Available factors depend on system 
capability. 

Examples: 

1.20x (native resolution) 1.50x (native 
resolution) 2.00x (native resolution) 
etc. 

 

DSR Smoothness OFF 

0 - 100% 

 

Dynamic Boost On, Off  

Enable overlay Off 

On 

 

Exported pixel types 8-bpp and/or RGB555 format, None  

Image Sharpening Sharpening Off, Sharpening On: 

Sharpen slider: 0-1.0 

Ignore Film Grain slider: 0-1.0 GPU 
Upscaling check box 

 

Low Latency Mode Off, On, Ultra  

Max Frame Rate Off, On (slider range 20-1000 fps)  

Monitor Technology G-SYNC/G-SYNC Compatible, ULMB, 
Fixed Refresh 
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Feature Values (Default in bold)a Notes 

3D Application Controls - Manage 3D Settings 

Multi-display/mixed-GPU 
acceleration 

Single, Compatible, or Multiple display 
performance modes 

 

Multi-GPU performance mode Single-GPU, alternate frame 
rendering 1 & 2, split frame 
rendering, or multi-GPU antialiasing 

 

OpenGL Rendering GPU Auto-select, NVIDIA NVS cards 

Optimize for Compute 
Performance 

Off, On Windows 10, Maxwell GPUs and 
later. 

Offers significant improvement 
for some Compute applications. 
Care should be taken when 
turning this setting ON, as there 
can be unpredictable effects 
with some applications and 
graphics features. 

Power management mode Adaptive, NVIDIA driver controlled, 
Prefer maximum performance, Prefer 
consistent performance, Optimal 
power 

NVIDIA Driver controlled GPUs 

Preferred Refresh Rate Application-controlled, Highest 
available 

 

Shader Cache Size Disabled, Limited, 128MB, 256MB, 
512MB, 1GB, 5GB, 

10GB, 100GB 

 

SLI performance modes Single-GPU, alternate frame 
rendering 1 & 2, split frame 
rendering, or SLI antialiasing 

 

Stereo - Display mode Select to match stereo viewing 
hardware 

 

Stereo - Enable Off, On  

Stereo - Force shuttering Off, On  

Stereo - Swap eyes Off, On  

Stereo - Swap mode Application Controlled, Per Eye, Per 
Eye-pair 

 

Texture filtering - anisotropic mip 
filter optimization 

Off, On  

Texture filtering - anisotropic 
sample filter optimization 

Off, On  

Texture filtering - Negative LOD 
bias 

Allow, Clamp  

3D Application Controls - Manage 3D Settings 

Texture filtering - Quality High quality, Quality, Performance, 
High performance 

Balance between quality and 
performance. 

Texture filtering - Trilinear 
optimization 

Off, On  

Threaded optimization Off, On For systems with multiple CPUs 
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Feature Values (Default in bold)a Notes 

Triple buffering Off, On  

Vertical sync Use the 3D application setting, Off, 
On, Adaptive, Adaptive (half refresh 
rate), Fast 

Adaptive settings are available 
only if Monitor Technology is 
set to ULMB or Fixed Refresh 
Rate. 

Virtual Reality pre-rendered frames Use the 3D application setting, 1, 2, 3, 
4 

Sets the frame pre- rendering 

Whisper Mode Off: Disabled by GeForce Experience 

On: Enabled by GeForce Experience 
and applied as a Global Setting. 
Frame rates are capped at 40 or 60 
fps, depending on the application. 

WhisperMode slider: Appears under 
Program Settings when enabled in 
GeForce Experience. 

Available on Pascal and later 
GPUs, on single-GPU 
configurations. 

3D Application Controls - Special Features 

PhysX Configuration  For systems with PhysX- 
capable GPUs, a minimum of 
256MB dedicated graphics 
memory, and a minimum of 32 
processor cores. 

SLI/Multi-GPU Configuration  For systems with SLI or multi-
GPU ready GPUs. 

Manage Power and Display 
Settings - Power Mode 

Power Balanced Quiet For certain enterprise- class 
notebooks based on the NVIDIA 
Turing GPU architecture, such 
as the NVIDIA Quadro RTX 6000 
notebook. 

Manage Power and Display 
Settings - Display Multiplexer 

Internal display multiplexer type 

External display multiplexer type 

 

 

• Defaults for the 3D application controls are for the Global Settings tab. Under the 
Program Settings tab, Use global setting is typically the default setting. 

3.2 NVIDIA Control Panel Groups 
This section provides an overview of the NVIDIA Control Panel groups. 

 Using the Display Pages  

 Using the Video Pages  

 Using the 3D Settings Pages  

 Using the Licensing Pages 

 Using the Developer Pages 

 Using the Workstation Pages  
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3.2.1 Using the Display Pages 
The actual tasks available on your system depend on your system hardware, such as the 
number and type of displays connected. Use the Display group pages to: 

 Run the wizard to optimize your display configuration. 

 Change the display resolution. 

 Change the scaling on your flat panel display. 

 Adjust desktop color settings. 

 Rotate the display. 

 Adjust custom timings. 

 Configure multiple displays, including Clone modes. 

 Adjust your television picture quality and video color settings for the best possible 
viewing in its environment. 

 Change the position and size of the desktop/video to best fit your television or 
HDTV (high-definition television) screen. 

 Change the signal format to use for your standard television or HDTV as well as 
change country-specific signal or the HDTV format. 

 Verify the HDCP capability of your system. 

 Access digital audio controls. 

3.2.2 Using the Video Pages 
The actual tasks available on your system depend on your system hardware, such as 
whether or not you have a TV connected and enabled. Use the Video page to: 

 Adjust video and image color settings. 

3.2.3 Using the 3D Settings Pages 
The actual tasks available on your system depend on your system hardware, such as 
whether you have an SLI-ready system. Use the 3D Settings page to: 

 Change the image and rendering settings of your 3D applications and games 
that utilize Direct3D and OpenGL technology. 

 Assign specific 3D settings to a game so that these settings automatically load when 
a game is launched (available under Advanced view). 

 Set up your SLI or multi-GPU configuration as well as PhysX configuration. 

GPU temperature monitoring and GPU overclocking features are not included in the 3D 
Settings page. To use this functionality, you must install NVIDIA nTune software. 

3.2.4 Using the Licensing Pages 
Use the Licensing pages to obtain licenses for NVIDIA GRID vGPU or NVIDIA Quadro Virtual 
Datacenter Workstation (Quadro vDWS) on supported Tesla products. 
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The Licensing pages are available if the vGPU requires a license, or if the GPU or driver 
supports GRID licensed features. 

3.2.5 Using the Developer Pages 
Use the Developer pages to control settings specific to developers who need to user 
NVIDIA developer tools. 

3.2.6 Using the Workstation Pages 
The Workstation group is available if you have an NVIDIA Quadro graphics card installed. 

The actual tasks available depend on which NVIDIA Quadro product you have installed. Use 
the Workstation page to: 

 Synchronize your displays using frame sync or genlock technology. 

 View a graphical representation of the displays and graphics cards installed on your 
system. 

 Configure Mosaic mode to combine multiple displays into a larger virtual canvass. 

 Configure ECC control on supported GPUs. 

 Overlap the edges of adjacent displays. Display edge blending is no longer available. 
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Appendix A. Professional 3D Stereo 

This appendix discusses professional or quad-buffered 3D stereo. It contains the following 
sections: 

 About Workstation 3D Stereo  

 Using Workstation 3D Stereo  

A.1  About Workstation 3D Stereo 
The NVIDIA graphics driver comes with built-in support for 3D stereoscopic viewing of 
OpenGL applications developed for 3D stereo. This is also referred to as professional, 
workstation, or quad-buffered stereo. 

A.1.1 Basic Workstation 3D Stereo Requirements 
To use workstation stereo, you need the following: 

 OpenGL application that is developed for stereo 

The application must be designed to render different content to the left and right eye. 

 NVIDIA RTX/Quadro graphics card, except NVIDIA Quadro NVS cards 

 Proper driver configuration through the NVIDIA Control Panel 

A.1.2 Using 3D Stereo under Different System 
Configurations 

The NVIDIA drivers support both full-screen and windowed stereo. Workstation Stereo 
Configurations details which stereo modes are supported under which GPU/display 
configurations.   

Table 9. Workstation Stereo Configurations 

System Configuration Active Stereo Display Modes Passive Stereo Display Modes 

Single GPU - Single display Supported Supported 

Single GPU - Multiple displays Not supported Supported (including CloneMode) 

Multi-system - Multiple displays Not supported Not supported 

Multi-GPU Mode Not supported Supported (including CloneMode) 
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System Configuration Active Stereo Display Modes Passive Stereo Display Modes 

SLI mode Not supported Not supported 

A.2  Using Workstation 3D Stereo 

A.2.1 Basic 3D Stereo Setup 
Set up the 3D stereo viewing hardware according to the instructions that came with your 
hardware. 

1. Start the system, then right-click the desktop and click NVIDIA Control Panel to 
open the panel. 

2. From the Select a Task pane, click Manage 3D Settings, then click the Global 
Settings tab. 

3. Under the Settings: Feature column, click Stereo - Enable, then click the 
corresponding Setting list arrow and select On. 

4. Click Apply. 

A.2.2 Selecting the Stereo Display Mode 
Typically, the driver detects the type of stereo hardware that is installed and automatically 
selects the appropriate display mode. If you cannot view 3D stereo with your application 
after these steps, then manually select the display mode as follows: 

1. Re-open the Global Settings tab in the NVIDIA Control Panel Manage 3D Settings 
page. 

2. Under the Settings: Feature column, click Stereo - Display mode, then click the 
corresponding Setting list arrow and select the stereo display mode that is 
appropriate for your stereo viewing hardware. 

See Supported Stereo Display Modes for a description of the available modes. 

3. If you want to use passive stereo using nView Clone mode, be sure to set up Clone 
mode using the Set Up Display Configuration page. 

4. Click Apply. 

Table 10. List of Supported Stereo Display Modes 

Option Description Hardware Examples 

On-board DIN connector Time sequential, page-flip stereo, with 
stereo shutter glasses connected directly 
to a 3-pin DIN VESA connector. 

 

On-board DIN connector 

(with NVIDIA IR Emitter) 

Time sequential, page-flip stereo, with 
NVIDIA IR emitter connected to the 3-pin 
DIN VESA connector via dongle. 

NVIDIA GeForce 3D Vision 
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Option Description Hardware Examples 

Generic active stereo Any time sequential, page-flip stereo Displays which accept time- 
sequential stereo signals 

Generic active stereo 
(with NVIDIA IR Emitter) 

Any time sequential, page-flip stereo 
using the NVIDIA IR emitter 

NVIDIA GeForce 3D Vision 

nView Clone Mode Uses projectors from two displays in 
nView Clone mode–left image on one 
display, right image on the other. Passive 
polarized filters (glasses) isolate the left 
and right images to the corresponding 
eyes of the viewer. 

Dep3D System 

nView Clone Mode 
(with NVIDIA IR Emitter 
using external stereo 
signal) 

Clone mode passive to active stereo 
conversion - the left/right images are 
displayed through separate monitor 
outputs and converted to active stereo by 
the display. 

The display feeds the stereo toggle signal 
into the NVIDIA IR emitter using a 3-pin 
DIN stereo cable. 

projectiondesign F10 

Vertical interlaced stereo 
monitor 

Vertical pixel columns alternate between 
left and right images. A beam splitter 
directs the left and right images to the 
corresponding eyes of the viewer. 

SeeReal Technologies 

Color interleaved display Custom implementation for the Sharp 3D 
Display, an auto- stereoscopic display that 
uses a parallax barrier technology to 
provide 3D stereo on the LCD. 

Sharp3D Stereo Digital Flat Panels 

Horizontal interlaced 
stereo display 

Horizontal scan lines alternate between 
left and right images. Passive polarized 
filters (glasses) isolate the left and right 
images to the corresponding eyes of the 
viewer. 

VRex, Inc. 

3D DLP display Projector or rear projection TV using Texas 
Instrument’s Digital Light Processing 
(DLP) technology. 

Requires shutter glasses. 

Samsung or Mitsubishi DLP HDTV 
with shutter glasses 

3D DLP display 
(with NVIDIA IR Emitter) 

Projector or rear projection TV using Texas 
Instrument’s Digital Light Processing 
(DLP) technology. 

Requires NVIDIA GeForce 3D Vision IR 
emitter. 

Samsung or Mitsubishi DLP HDTV 
with NVIDIA GeForce 3D Vision 

3D DLP display INV mode Use if the “3D DLP display” option results 
in reversed eyes. 

Samsung or Mitsubishi DLP HDTV 
with shutter glasses 

3D DLP display INV mode 
(with NVIDIA IR Emitter) 

Use if the “3D DLP display (with NVIDIA IR 
Emitter) ” option results in reversed eyes. 

Samsung or Mitsubishi DLP HDTV 
with NVIDIA GeForce 3D Vision 
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A.2.3 Using Workstation 3D Stereo with Multiple 
Displays 

In a multi-display system, you can move the OpenGL application window to all monitors, 
although stereo might not be visible on all monitors. 

A.2.3.1 Enabling 3D Stereo with Multiple Displays 
To make sure that you successfully enable 3D stereo in a multi-display configuration and 
avoid losing stereo settings, NVIDIA recommends first enabling stereo in single-display 
mode and then closing the NVIDIA Control Panel before setting up multi-display modes. 

1. Enable 3D stereo 

• Open the NVIDIA Control Panel, then set single-display mode using the Set 
Up Multiple Displays page. 

• Set stereo settings using the Manage 3D Settings page. 

• Close the NVIDIA Control Panel. 

2. Enable multiple displays. 

• Using either the Windows Display Properties page or by re-opening the 
NVIDIA Control Panel -> Set up Multiple Displays page, set the desired multi-
display mode. 

3. Set up other NVIDIA Control Panel -> Workstation settings as needed, such as frame 
locking. 

A.2.3.2 3D Stereo Under RTX Desktop Manager Modes 
Under NVIDIA RTX Desktop Manager multi-display modes, both displays must be set to the 
same resolution and refresh rate. If the refresh rates are different, the 3D stereo will be 
displayed on the display with the highest refresh rate. 

A.2.3.3 3D Stereo Under Dualview Modes 
Under Dualview mode, all displays must be set to the same refresh rate for 3D stereo to be 
displayed on all the Dualview displays. If the refresh rates are different, 3D stereo will be 
displayed on the display with the highest refresh rate. 
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Appendix B. NVIDIA Application 
Configuration Engine 

This appendix discusses the NVIDIA application configuration engine (ACE) for professional 
workstation applications. It contains the following sections: 

 Introduction  

 Using ACE with Supported Applications  

 Using Applications that Are Not Supported by ACE 

 Adding to the List of ACE-Detectable Applications  

 Frequently Asked Questions  

B.1 Introduction 

B.1.1 Background 
Workstation application profiles are a group of software settings used by the NVIDIA 
graphics driver to provide optimum performance when using a selected application. If 
there is an available profile for an application, it should be used to ensure correct 
application behavior and optimal performance. 

B.1.2 About NVIDIA ACE 
With the NVIDIA application configuration engine (ACE), the graphics driver can now 
detect supported workstation applications and apply the appropriate profile settings 
automatically–you no longer need to manually select the profile from the NVIDIA Control 
Panel. If you run more than one application at a time, ACE makes sure that the driver 
applies the appropriate profile settings to each application. 

B.2 Using ACE with Supported 
Applications 

When you run an application that is supported by ACE, you do not need to do anything 
special. The driver will detect the application and apply the appropriate profile settings 
automatically. 
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B.2.1 How to Determine ACE Support 
To determine whether your application is supported by ACE: 

1. Open the NVIDIA Control Panel. 

2. From the Select a Task pane, under 3D Settings, click Manage 3D Settings, then 
click the Program Settings tab. 

3. The Select a program to customize list box contains a list of the ACE-detectable 
applications. 

Figure 4. Manage 3D Settings Page - ACE-Detectable Applications 

 

B.2.2 Modifying Settings for ACE-detectable 
Applications 

You can modify the settings as follows: 

1. Select the application from the Select a program to customize box.  

The settings for the application are listed in the Specify the settings for this 
program box. 

2. Click the setting you want to change and then select the new setting from the drop-
down list. 

3. Click Apply when you are finished making your changes. 
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B.3 Using Applications that Are Not 
Supported by ACE 

If your application is not detectable by ACE, then you should configure an application 
profile and make sure it is set before running the application. 

B.3.1 Setting Up an Application Profile Using Global 
Presets 

1. From the Manage 3D Settings page, click the Global Settings tab.  

2. Click the Global Presets list arrow. 

Figure 5. Manage 3D Settings Page – Applications with Global Profiles 

 
3. Select one of the global presets: 

4. Select a Base profile, one of the generic 3D App profiles, or create a new profile 
(see Adding to the List of ACE-Detectable Applications). 

5. In the Settings box, you can modify the profile by clicking the setting you want to 
change and then selecting the new setting from the drop-down list. 

6. Click Apply when you are finished making your changes. 

If you run a different application that is not ACE-detectable and do not want to use these 
settings, then repeat these steps for the new application. 

Be aware that these settings may affect any ACE profile settings that specify Use global 
setting. 
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B.3.2 About the Global Presets 
Global profiles, or presets, are a set of 3D settings that the driver applies to any 
workstation application. While a specific profile contains settings that work best with a 
particular application, the settings are applied to any workstation application you run, as 
long as there are no ACE- detected program settings to override them. 

The following are descriptions of the available global presets: 

 Base profile 

This preset lets you configure all the settings, and provides the most flexibility. 
Other presets allow you to configure only a limited selection of settings. 

 3D App - Default Global Settings 

This preset uses SLI single-GPU rendering mode, and is also useful when you 
need to use non-SLI configurations. 

 3D App - Game Development 

This preset is useful for game development when using an NVIDIA Quadro card. 
This eliminates the need for game developers to switch to a GeForce graphics card 
as the settings cause the Quadro card to run like a GeForce card. 

 3D App - Modeling AFR 

This preset is useful for modeling applications, and uses SLI AFR mode. 

 3D App - Visual Simulation 

This preset is useful for visual simulation applications, and uses SLI SFR mode. 

B.4 Adding to the List of ACE-Detectable 
Applications 

If your application is not listed in any of the profile lists in the Global Settings or Program 
Settings tab, then you can create a profile for that application as follows:  
 

 
Note: If your application is listed in the Global Settings tab, then do not create a new 
profile. Instead, set the global preset for that application. 

 

1. From the Manage 3D Settings page, click the Program Settings tab. 

2. Click Add. 

3. In the Open dialog box, navigate to the location of your application executable, then 
choose the executable file name and click Open. 

4. The file name appears in the Select a program to customize list box. 

5. In the Specify the settings for this program box, configure any settings by clicking 
the setting you want to change and then selecting the new setting from the drop-
down list. 

6. Click Apply when you are finished making your changes. 

The new profile will be applied automatically whenever the application is run, just like one of 
the default ACE profiles. 
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If your application was running while you created the new profile, you must restart the 
application for the settings to be applied. 

B.5  Frequently Asked Questions 
 What happens when I run more than one ACE-detectable application at the 

same time? 

The driver detects each application and applies the appropriate profile to each one 
automatically. 

 What happens when I run an ACE-detectable application and a non-ACE-
detectable application at the same time? 

The driver applies the global preset to the non-ACE-detected application, and applies 
the appropriate profile to the ACE-detected application. Note that any settings in the 
ACE profile that specify Use global setting will be controlled by the global preset. 

 Can I create my own application profile? 

Only one profile can be created for a specific executable, so if your application is ACE- 
detectable, do not create another profile for that application. 

If your application is not ACE-detectable, and there is no global preset for it, then you 
can create a new profile as described in Adding to the List of ACE-Detectable 
Applications. 

 Can I create a new global profile for a specific application? 

For applications that are not detected by ACE, you can select an existing global preset 
and customize it, but you will not be able to save it under a custom name. 

 Which global preset should I use? 

Unless you know that a specific global preset is appropriate for your application (see 
About the Global Presets), it is best to use the Base profile. 
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